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Preface

This document is intended for users of the ClaimMaster system, those supporting ClaimMaster, and the system administrators. The installation section is for system administration and support personnel, and the daily use guide is for the billers. This document only covers physician claims, and another document covers institutional claims. 

Revision History

	Date 
	Author
	Reason
	Version

	4/23/2015
	Kris Pepper
	Formatting of Document
	R8

	4/1/2012
	Kris Pepper
	Added Railroad Medicare
	R7


System Overview

ClaimMaster sends claims that are printed in Lytec to your insurance company. ClaimMaster will send claims to Empire Medicare, GHI Medicare, Medicaid and Blue Shield and Railroad Medicare. It will also process the remittances that each of these return. 

Users first make arrangements with the insurance company directly to send electronic claims and perhaps receive electronic remittances. The insurance company will provide a submitter id and indicate what tax and npi codes should be used. 

Lytec produces a file when the claims are printed. ClaimMaster picks up that file and creates a new file in its folders. ClaimMaster can look into Lytec to fill in some claim information when creating that insurance file. The user can view the insurance reports before sending the claims, and ClaimMaster will hold back any errors it finds. It will only hold back the claims in error, and let the other claims through. Finally, ClaimMaster will let the user package the claims for uploading to the insurance company, which will copy the claims to a preset folder. 

Claims reach the insurance by different methods for each insurer. Some insurers provide a web site for uploading, while others allow a modem to modem connection and still others allow a network service provider to send claims via a secure connection installed on your computer. 
The insurance company will respond with a few levels of review. It will first accept or reject the transmission. Then it will pre-process the entire batch and reject it if it finds structural errors. This preprocess is a 999 report, and some insurers only send it when there are errors. It is followed by a quick process that kicks out individual claims with bad information. This is a 277 report, and is very important. The rejected claims will receive no acknowledgement on the final EOB. ClaimMaster will read all these reports, but the user must download the reports to ClaimMaster. The download methods differ for each insurer.  

The final EOB will arrive either on paper or in electronic form a few days or weeks later. The time depends upon the insurance company policy. Rejections often arrive earlier than the accepted claims. If the user contracted with the insurance company to receive the EOB electronically, ClaimMaster can print a rough report. Medicare's EasyPrint can be used to print a formal EOB instead. Some EOBs can have formats that Lytec cannot process properly. ClaimMaster can preprocess the EOB to make it work with Lytec's auto remittance processing, but ClaimMaster does not directly post the claim. 

Daily Use:

Overview: 

ClaimMaster sends claims that are printed in Lytec to your insurance company. ClaimMaster will send claims to Empire Medicare, GHI Medicare, Medicaid and Blue Shield. It will also process the remittances that each of these return. 

After entering your claims in Lytec, you print a billing report to give them to ClaimMaster. First, you print the claims for one insurance company in Lytec. Then, you process the Lytec billing file in ClaimMaster to create a HIPAA compliant transmission file.  That transmission file travels to the insurance company in the way that the insurance company determines, using the options that are lit for that insurance company. 

Detailed step-by-step instructions follow. 

1. Enter your claims in Lytec as you would normally. There are special instructions for secondary claims: 

For medicare, set up the reason medicare is secondary on the billing options / secondary insurance tab. 

For secondary claims, you may have to enter the payment information. It is different depending on how you set up your system:

	SETUP
	What you must enter for secondary claims

	If you use ClaimMaster’s payment table
	 If the normal amount is paid, you don’t have to enter anything. If a different amount is paid, (usually due to a deductible), enter the claim detail allowed and paid custom fields. 

	If you charge the allowed amount  (and set your primary insurance’s custom field 4 to Y) and do NOT use ClaimMaster’s payment table
	 For  both the bill detail custom field payment and allowed amounts when the primary paid less than 80% of the amount charged. Medicaid tells some practices to insert “U2” as the first claim modifier also for a deductible.   

	If you do not charge the allowed amount and do NOT use ClaimMaster’s payment table
	You will always need to enter the paid amount for secondary claims. For a line with a deductible, you will always need to enter the amount paid. If the normal amount (either 80% or 50% depending on the practice) was paid, you only need to enter the payment amount and ClaimMaster will calculate the allowed amount. 

	If you want to summarize all detail lines into one for Medicaid secondary for physical therapists (and your insurance custom field 2 is set to “PTCD”)
	Note: Medicaid does not seem to be paying any more right now for multiple units, so this feature may not be worth using anymore. 

Enter the total units in  custom billing field 6 (billing / custom fields), and you do not have to enter the payment amount. If there was a deductible, just enter the allowed amount for the total of all lines on the first line. 

	If you are a podiatrist performing procedures 11055, 11056, 11057, 11719, 11720, 11721 (and if below 2010, then set insurance custom field 2 to "SPVR")

	Be sure to enter consult date 2 which will come through as date last seen (304). If below 2010, be sure to enter referring provider on bill. If 2010+, be sure to enter a supervisor on the bill. 

	If you are billing for a chiropractor, 
	be sure to enter the consult date 1 as initial treatment date. It will be used for initial treatment date(454), date last seen (304) and date of acute manifestation (453). If the date last seen should be different, put that into consult date 2. 


If you needed to enter the allowed or paid amount for a line: hit the <detail> button and then the <custom fields> option and fill in the allowed amount in custom field one and the paid amount in custom field two. 

Sometimes Medicaid wants practices to send a modifier of U2 to indicate a deductible. If your practice is supposed to (and most are), please also change the modifier of the line to U2. 

2. Print your claims in Lytec.

a. Select the Billing Menu, and choose print insurance claims. 

b. Choose the edi form that matches your insurance company's name. For secondary claims, be sure to choose the form that is named with “sec”. The same form name works for all different practices.

c. Enter your insurance company code to restrict claims to only one insurance company.

d. For clinic secondary claims only, be sure to check the include payments box. (If you use the PTCD feature, you must also check the include payments box.) 

e. Lytec will create a new claim file for each insurance company. You can append secondary and primary claims together, as long as they are the same insurance company. 

f. Please process an insurance company for one practice before moving to the next practice. Different insurances can be processed at the same time though because they write to different files.
3. Process your claims in Claim Master. 

a) Open Claim Master. Enter the password. When your system is delivered, the password is set to new. You must change that using “Change Password” on the File menu. 
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b) If the practice and insurance company you want do not display in the blue bar, open your practice by choosing Settings and then “Open Practice.” Double click on your company (so that you see it in the "look in" box), and then press "select".  (Do not double click on “config” or the insurance name.)  If you do not see your company, exit ClaimMaster and start again.

[image: image3.png]Open Practice - place practice next to ‘Look in’ & hit Select [2)(]





c) You are now back at the ClaimMaster menu. In the blue title bar, you will see the name of the last insurance company you used for this practice. 

d) If you want to process claims for a different insurance company, choose Settings and then “Select Insurance.” Double click on the correct insurance company. When you are done, you should see the insurance company in the blue title bar above the menu.
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e) Select the Lytec billing file by choosing File and then “Select Lytec Billing File.” Then, double click on the correct insurance company’s “.inp” file. (If you choose a file for the wrong insurance company, it will give you a warning and not allow you to process.) If it does not show your Lytec billing file, see the troubleshooting section below for “Cannot find Lytec billing file.”

[image: image5.png]



f) Process your claims by choosing the  run  menu option and then “process”.  ClaimMaster will prompt you with a message to be sure you are matching insurance companies. Press enter.  If it asks you to over-write, you can press enter again. 
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g) ClaimMaster will prompt you with a message listing the number of valid and invalid claims. Note whether you have invalid claims. 
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h) If you had invalid claims, choose view  and then “invalid claims.” It will display all report names, with the current report already selected. Just press <ENTER>. Your invalid claims report will display. 

i) If you had valid claims, you can view or print them by choosing view and then “valid claims.” It will display all valid report names, with the current report already selected. Just press <ENTER>. 

4.  You are are now ready to transmit. The options you need for the insurance company are turned on in the transmission menu. Choose the steps based on the insurance company below:

For GHI Medicare directly: 

Transmit the claims from Claim Master, and download from Claim Master using the following steps: 

a) Choose the Send/Receive Menu option and the Connect now option. (If the connect now button does not do anything, please exit and re-enter Claim Master.) 

b) Press "enter" to accept the modem settings. (If you have more than one modem, select the correct one.)  You will then see the following transmission screen: 
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c) Press "connect". It will dial. 

d) Enter your  logon and password.

e) If this is the first time you are signing onto GHI Medicare, it will ask you to change your password to an 8 character password that includes a special character (such as *) and a number. Also, you will choose set up your user configuration:

a. Choose 4 for User configuration

b. Choose 1 for Transfer protocol

c. Choose 1 for ZModem

d. Choose enter to accept 

e. Choose 2 to "Select Compression type"

f. Choose  5 for no compression type (unless you want to manually apply an unzip program to each download)

g. Choose X to go to the main menu

f) To send  claims to GHI Medicare: 

· Choose 1 and "enter" to "Transmit Files" 

· It will say "Start your file transfer"
· Hit the upload button. 

· Press enter to choose the claim you just processed. (You could also choose older claims that have not been sent.) 

· You may see it wait a while after the progress bar is complete. When the ClaimMaster upload window disappears, you will need to press enter to see the "receive completed" message.

g) If you want to download from GHI Medicare: 

· (This can be done from the same connection.) 
· Connect and enter your login and password. 

· Choose 4 for User configuration

· Choose 2 to "Select Compression type"

· Choose  5 for no compression type (unless you want to manually apply an unzip program to each download)

· Choose X to go to the main menu

· Choose 2 and "enter" to receive files (and it will prompt you to retrieve all files you have not yet retrieved). 
· The screen will print " Start your file transfer"

· Hit the download button. 

· If it asks again to "Start your file transfer", hit the download button again. Keep repeating until it is done.

· (If you want to receive a specific file to  a second time,  you can use option 3 to list files and download from the list instead. )
· Files you can expect: 

1. Receive a TRN immediately to say the file was sent.

2. Within an hour, receive 997 and GEN. In the 997, look for all accepted.

3. Within 24 hours, receive a RPT validation report.   
h) When you are done, hit the "disconnect" button. 

i) Hit the "X" button to close the transmission window. 

j) If you did not upload all files for this insurance, it will ask whether you want to delete them. If you do not want to ever send a particular claim file, highlight it and press delete.  

For GHI Medicare via Ivan's:

a. Select lytec billing file and run as usual

b. Send / Package to Send

c. Exit to desktop 

d. Click the AT&T connection icon

e. Click the GHI Medicare Blue Zone icon which Ivan's will create for you.

f. Send the C:\CLAIMS_GHIMCARE\GHIMCARE.CLM file

g. Receive a TRN immediately to say the file was sent.

h. Within an hour, receive 997 and GEN. In the 997, look for AK5*A towards the end. If not, download the file to open with claimmaster. 

i. Within 24 hours, receive a RPT validation report. Save that one. 

For PA or NJ Medicare: 

Transmit the claims from Claim Master, and download from Claim Master using the following steps: 

a) Choose the Send/Receive Menu option and the Connect now option. (If the connect now button does not do anything, please exit and re-enter Claim Master.) 

b) Press "enter" to accept the modem settings. (If you have more than one modem, select the correct one.)  You will then see the transmission screen:

c) Press "connect". It will dial. 

d) Enter your  logon and password. (Case matters, so be sure to use the correct case.) You will see the following: 

e) To upload claims to PA or NJ Medicare: 

· Choose "xs" and press "enter". (The menu says "s", but use "xs".)

· Wait until you see <START>

· Choose the "upload" button.

· Press enter to choose the claim you just processed. (You could also choose older claims that have not been sent.) 

· See upload completion message.

· Choose "xack" and press "enter" to get the 997 report. (The menu says "g", but use "xack".)

· Hit the download button right away, and then wait a few minutes if necessary Medicare is producing the report while you wait.) 

· See the download box disappear

f) To download the MCS Edit report for PA or NJ Medicare: (It will be available 2 business days after the upload and will only last for 5. If claims are rejected here, you will not be notified again.)

· Type "a"  and <Enter>

· Hit the download button right away, and then wait a few minutes if necessary 

· See the download box disappear

g) To download the ERA Remittance report for PA or NJ Medicare: (It will only be available for 5 business days, so please check weekly. )

· Type "xr" and <Enter>. (The menu says "r", but type "xr".)

· It asks whether you are ready to receive, so type "Y" and <Enter>.

· Hit the download button right away, and then wait a few minutes if necessary 

· See the download box disappear

h) When you are done, hit the "disconnect" button. 

i) Hit the "X" button to close the transmission window. 

j) If you downloaded a report, view it using the View menu Download option.

k) If you did not upload all files for this insurance, it will ask whether you want to delete them. If you do not want to ever send a particular claim file, highlight it and press delete.  

For NY Railroad Medicare: 

Transmit the claims from Claim Master, and download from Claim Master using the following steps: 

a) Choose the Send/Receive Menu option and the Connect now option. (If the connect now button does not do anything, please exit and re-enter Claim Master.) 

b) Press "enter" to accept the modem settings. (If you have more than one modem, select the correct one.)  You will then see the transmission screen:

c) Press "connect". It will dial. 

Enter your  logon and password. (Case matters, so be sure to use the correct case.) You will see the following:  
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d) To upload claims: 

· choose 2 to upload and press <ENTER>

· You will see a screen that asks you to choose the transfer type. Type Z  (with no enter)
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· Choose the "upload" button.

· Press enter to choose the claim you just processed. (You could also choose older claims that have not been sent.) 

· See upload completion message.

· Choose 1 and press "enter" to get the 997 report.  
· Type Z for ZMODEM followed by Y to download all files.
· Hit the ClaimMaster download button right away, and then wait a few minutes if necessary   

e) To download reports:
· Choose 1 and press "enter" to get the 997 report.  

· Enter Z for ZMODEM and press <ENTER>.

· Hit the ClaimMaster download button right away, and then wait a few minutes if necessary   

f) When you are done, hit the "disconnect" button. 

g) Hit the "X" button to close the transmission window. 

h) If you downloaded a report, view it using the View menu Download option.

i) If you did not upload all files for this insurance, it will ask whether you want to delete them. If you do not want to ever send a particular claim file, highlight it and press delete.  

For Medicaid, Empire Medicare and Blue Shield and Emdeon and Availity: 

Package the claim to be sent, and then send the claims by connecting to the insurance claim web site, and then tell ClaimMaster the file was sent:

a) Choose the Send/Receive menu option and then “package to send.” 

b) If the last sent of claims have not already  been marked as sent, it will ask you if the last file was sent.  If you press yes, it will mark them as sent. If you press no, it will just add the new claims to the file waiting to be sent. 

c) Press <ENTER> to package the claim you just processed.

d) Minimize Claim Master. 

e) For Blue Shield and Empire Medicare: send your claims through Ivans  by doing:

· Connect to AT&T.

· Sign onto Ivan's.

· Choose send files

· Click the send and production boxes, and enter " C:\ASEND_MCARE” for Medicare and C:\ASEND_BLUE for Blue Shield. (For a test submission, first change to test mode using file / change insurance / change insurance test status.)

· Hit the “send” button to submit the claims.

· You will be able to press “get files” to see whether the claims were submitted about 2 hours later. Within 3 days, you will be able to download a report indicating whether the claims were accepted. When you get files from Ivan’s you can download them to the download directory for the practice’s insurance. That directory is set by the insurance options in ClaimMaster. If you don’t specify a folder, it assumes c:\claimmaster\<practice name>\EMPCARE\download, or c:\claimmaster\<practice name>\BLUE\download. Anything in ClaimMaster’s download directory will be easily seen with ClaimMaster’s view / download option. 

f) For Medicaid send your claims directly through the internet  by doing:

· Connect to web option.

· Sign onto emedny.

· Choose send files.

· Change the type to professional claims (except for clinic, which is institutional).

· Choose the Medicaid upload file, (usually C:\ASEND_MCAID).  

· Hit the “send” button to submit the claims.

· You will be able to look at your inbox to see whether the claims were submitted soon after. Within a few days, you will be able to download a report indicating whether the claims were accepted. You can download reports to the download directory for the practice’s insurance. That directory is set by the insurance options in ClaimMaster. Anything in ClaimMaster’s download directory will be easily seen with ClaimMaster’s view / download option. 

g) For Availity - connect to the Availity site and follow instructions. Choose the transmission file claimmaster prepared

h) For Emdeon - connect to the Emdeon site and follow instructions. Choose the transmission file claimmaster prepared.

i) Maximize ClaimMaster. 

j) Choose the Send/Receive menu option and then “Mark as sent” and press <Enter>. 

Exit claim Master by choosing the File menu and then selecting “Exit.”

Extra Features:

If you want to see what dates you sent each transmission: 

· Choose view / sent claims.

· You will see a list of claims you sent with the date the file was sent. You cannot see the contents of that transmission from this screen.

If you want to view downloaded files: 

· Choose view/ download files. 

· Double click on the file you want to see. 

If you want to view reports from prior runs: 

· Choose view / invalid or valid reports

· Choose the older report by double clicking on it's transmission number. (It may help to press the upper right button to display file details, which will give you the date of the transmission.)  

If you want to rerun a Lytec claims file, but you have already replaced it: 

· Choose select billing file

· Change files of type to (*.cpy) using the down arrow. 

· Navigate to the insurance output directory by pressing the down arrow under "look in". 

· Double click on the .cpy file for that transmission. (It may help to press the upper right button to display file details, which will give you the date of the transmission.)  

· Choose run/ process. 

If you want to never send a claims file:   

· Choose File / Delete ClaimMaster Claim file.

· Double click on the file that you want to never send.

If you want to change your password:   

· Choose File / Change password.

· Enter your new password twice.

If you want to reset the last transmission number:   

· Choose settings / Reset Last Tran ID

· Enter the new Transaction ID – It will effect the next transmission, but not any that have been previously selected. 

If you want to prepare Remittance files for Lytec:   

· Choose Remit / Process Remittance

· Select the file you want to process from the download directory.

INSTALLATION GUIDE

1. Download the latest release from www.octagonsys.com

2. Double click on the cminstall icon and enter the following: 

2.1. Read the Installation Start screen and press <NEXT>. Then, read and accept the license by pressing <YES>.  You will the  be asked for you name, company and serial number. In “Serial Number,” enter the exact Serial Number given to you, including any dashes. You can enter DEMO-0000 if you do not know and ask for a license later.  You must enter both a company and a name. Then choose “NEXT”.
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a. You will then be told that the installation directory will be c:\program files\Octagon Systems\Claim Master. You can change the installation directory by pressing <Browse>.  Press <NEXT> when you are done. 

b. Choose a typical installation and press <NEXT>.

c. You will then be told that ClaimMaster will be placed on the start menu into a folder called  “ClaimMaster”. You can change this if you prefer. Press <NEXT> when you are done. 

d. ClaimMaster then asks you questions to determine which forms to give you. Click Yes or No to answer whether you will use different insurances. Then tell the system whether you use the same insurance code in Lytec for primary and secondary claims. If even one of your practices uses the same insurance code for both primary and secondary claims, then press “YES”. 

e. You will then be prompted for your data directory name.  You can browse to change this. Normally, people choose the same root folder that holds all their Lytec Data. Press <NEXT> when you are done. (NOTE: If you used DEMO-0000, it will default to the demo folder. Instead, please navigate to your Lytec folder so that it does not point into your program folder. )

f. It will then ask you whether you want to set up a default practice. Only enter the practice name here if you always want ClaimMaster to start with this practice whenever you open it. It should not have commas or other special characters. 
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g. Click <Finish> to complete.

3. Set up your practice in claim master

a. Open claim master  by double clicking the shortcut, or choosing it from the start menu.

b. Choose to open practice. 

c. If you don't see the practice, you could click on the new folder icon to create your practice. Create your practice as one word.  Press <ENTER>. This should not 

d. Double click on the practice you want. It will appear in “Look In”.

e. Choose "select". 

f. Create your insurances for just one practice from the templates by 

1. choose File 

2. choose Create New Insurance from Template.  

3. double click the insurance you want.

4. insert the practice name without special characters before the insurance name

5. hit Enter

6. hit OK

7. repeat for each insurance type.

g. Select the insurance by

1. choose Settings

2. choose Select Insurance

3. double click the insurance

h. Set the System Defaults

1. Choose settings.

2. Choose Reset System Defaults. By default, every insurance will send NPI claims.

3. Choose Change System defaults 

4. down arrow next to New System Version to click on the correct version. 

5. Hit Save. Hit OK. 

4. Set up parameters for your practice:

· Please see the "Add a new practice" section below. 
5. To test: in Lytec, print a claim using each of the insurance claim forms.

6. In Claim Master, select the insurance input file and then run / process your claims.

Add a New Practice:

4. Create your practice in ClaimMaster.

a. Open ClaimMaster from the start /program menu.

b. Choose the Settings menu and select “Open Practice.”

You should see all the other practices ClaimMaster handles for you. (If it does not, exit ClaimMaster and start over.)  

c. Double click on [image: image13.bmp] ( the new folder icon) to create your practice. (If you hover your cursor over the icon, it will say “new folder”. )
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d. Type your practice name as one word. (It does not have to match anything.)   Press <ENTER>. (This names the folder that will contain your practice.) 

e. Double click on the practice you just created. It will appear in “Look In”.

f. Double click the Select Button. [image: image15.png]


 

5. Add the Insurance Configuration to ClaimMaster.   

a. Choose the File menu option and select “Copy insurance or table file” to copy the configuration of another of your practices. 

 (If you prefer, you can choose “Create new insurance or table from template” instead.)

b. Double Click on the practice you want to copy.

c. Double Click ONLY on the “config” folder, NOT an insurance name.

d. Double Click on the insurance name you are creating. 

(Never copy from a different insurance.)

e. ClaimMaster will ask you for a new name: 

[image: image16.png]Flease enter a new parametr fie

[eenetomnedead

[

cone_|





f. Type the practice and insurance name so you will recognize it,  and click ok.  

g. Please follow the Configuring ClaimMaster section of this manual. 

Configuring ClaimMaster

This section starts with an insurance that has already been created in ClaimMaster, but needs to be configured.  

1. Configure the Insurance Practice Values: 

2. Choose file / Change insurance practice values

3. Double click your insurance to see the following screen: 
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           Set the following values and then press “save” and then “ok”. 

· Configuration: enter your practice name followed by "mcaid" or “mcare” or “blue”. If necessary shorten the practice name.

· Report Name: enter your practice and insurance name.

· Lytec data dir:  hit the <browse> button to find the folder that will hold your Lytec insurance form. For Lytec 2005, this is the Lytec directory in the Program Files folder on your C drive. For all other versions of Lytec, this is the Lytec data directory on your server.

· Submitter Name: Enter the submitter name exactly as it appears on your license.

· Electronic Submitter ID: Enter the submitter ID your insurance company assigned to you. (This is called an ETIN for Medicaid.) 

· Contact Name: Enter your name in contact name.

· Phone: Enter your phone number in phone, without any dashes.

· Lytec Practice Name: Enter the Lytec Practice Name that you find in Lytec’s Settings / Practice. You only need to enter a portion of the Lytec Practice Name. This will be used to match the practice in the claim file to be sure you are not processing the wrong company.

· For Empire Medicare, Blue Cross and Medicaid:

· Output Claims Filename: Change this filename to indicate your practice.

1. Download Directory: .

· If you send secondary claims for this insurance: 

· Pay Rate: This indicates the percentage of allowed amount at which the majority of your claims are paid. If the normal rate is 80%, enter “.8”. If the insurance usually only pays 50%, enter “.5”  

· Use Prim Payor ID: If your claims are ever secondary to anything other than Empire Medicare, uncheck the “Use Prim Payor ID” box. You will then need to ensure you have the correct payor ID in Lytec’s insurance payor id fields.

· Primary Payor ID: If your claims are always secondary to one insurance company, enter the primary payor id here. 13202 is Empire Medicare, BS803 is Blue Cross; 13292 is GHI Medicare; 141797357 is NY Medicaid; 12402 is NJ Medicare (was 00805); 12502 is PA Medicare (was 00865).; RR Medicare is C00882.
· For Medicaid Groups with Atypical providers only: 

· Locator POS Table: If your practice has only one locator code for each Lytec Facility code, leave this blank. Otherwise, you will need to first create a Locator POS table for this practice and then come back (using File / Change Insurance / Change Insurance Practice) to select that table using the browse button.

· LOC Default: Enter the  locator code that you want ClaimMaster to use when it cannot find any other locator code to use. (For example, if you are putting the locator on the facility code, and you didn’t put a facility on the bill. If you put nothing here, ClaimMaster will give you an error when it cannot find a match. If you intend to always enter a facility code, leave this blank.)  

· (Note that the facility insurance ID 2 or legacy id 2 will be used as the locator code.) 

· (Note that you will also have to fill in the NONPI table as described later in this document.) 

· For Medicaid Clinic Only: 

· POS Default: Enter the institutional place of service code for all claims.

· Revenue code: Enter the revenue code for all claims.

· Only rate: If you have only 1 rate, enter that only rate code here.  

· Only proc: Not used anymore.

· Procedure table file and match fields: If you have more than one rate code, and you don't want to put the rate code into modifier fields 1 and 2, fill in the procedure table file and at least match1 below it.  Browse to choose a procedure table file that matches the 5 "match codes" that follow it on the screen. ClaimMaster will pick up a claim and put together the words "RATEFOR" and then each of the values in the match codes that you chose, without any separators. Then, it will match that value against the first line in the table looking for a match. It will continue until it finds a match. Asterisks on the table indicate all characters after are a match, and the asterisk must be at the end only. (For example, if you match by CPT and PTTYPE, and the claim has a CPT of 90804 and a PTTYPE of 01, ClaimMaster will match RATEFOR9080401 to the procedure table, so this sample claim would match RATEFOR9080401, RATEFOR90804* or RATEFOR*.) Conversion note: 

	Old ins 6 value
	Procedure table template to use
	Match Codes to choose

	2
	none - use only rate 1610
	none

	3
	none 
	none

	4
	rate_proc_method_4.tbl from template
	CPT

	5
	rate_proc_method_5.tbl from template
	CPT

	6
	rate_proc_method_6.tbl and just choose existing. 
	CPT

	7
	rate_proc_method_7.tbl and just choose existing.
	PTTYPE in match1

CPT in match2

	8
	rate_proc_method_8.tbl and just choose existing.
	FEESCHED in match1

CPT in match2

DETCUST5 in match3


· Can primary have no contract: Check this box if  a certain patient type has secondary claims for Medicaid do not have a contract with a primary insurance.  (This only takes effect when you also fill in the patient type next to the check mark.)

· Patient Type: Only use this if you check the “Can primary not be contracted” box. The patient type listed here will be sent with a claim Adjustment reason code of 38 to indicate that the clinic is not contracted with any other insurance for this patient type. Be sure that the clinic is actually not contracted with other insurances, as sending an adjustment reason code of 38 will increase clinic payments and should never be used when the clinic does have contracts with other insurances.  Please verify with Medicaid that all patients of this type should have adjustment reason code 38. 
· For Receiver name for NM109_40, put ACTUAL for Clinic Medicaid Commercial (often emdeon) so that the actual payor id will be used. 
· Hit <Save>

· Hit <OK>

4. Select this new insurance company.

· Choose the Settings menu option and then “Select Insurance”.

·  Double Click on your new insurance company. You should see the practice and insurance company in the title bar. 

5. If you are need to create any table for the practice, create it now.

You will need  to create a physical therapy table if you are submitting physical therapy codes to Medicaid. You will need to create a locator table for Medicaid if you have more than one locator code per facility. You will need to create a pay table if you submit secondary claims for this insurance and have a pay table license.  For detailed instructions on what belongs in each of these tables, see the “ClaimMaster Tables” section of this manual.)

a. Choose the File menu option and select “Copy insurance or table file” to copy the configuration of another of your practices. 

      (If you prefer, you can choose “Create new insurance or table from template” instead.)

b. Double Click on the practice you want to copy.

c. Double Click ONLY on the “config” folder, NOT an insurance name.

d. Hit the down arrow next to “Files of Type” and choose table file.

e. Double Click on the table you are creating. 

f. ClaimMaster will ask you for a new name. Enter that name and choose ok. 

g. The table will display to you. You can make any changes you want.

6. You might want to change the insurance options as well. You want to do this if you have a physical therapy practice, or if you use a pay table, or if you want to name the download directory. 

h. Choose the File menu.

i. Choose Change Insurance or Table.

j. Choose Change Insurance Options.

k. Click on the <Open> button. 

l. See the following screen: 
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· Modem Info: If your modem requires dialing 9 first, insert "9," before the modem phone number. 

· Claim Submission Web Address: This is the internet address used by the Transmit / Connect to Web option. (For Medicaid, you will need to choose the login Xchange button first.)

· For Physical Therapy: Procedure Table File: This table file will replace one procedure code with another if it sees a match. For physical therapy, Medicaid wants a different code than Medicare, so you will need to enter a procedure table here. You can browse to find the correct directory.

· Table of providers without NPI: This table just lists the Medicaid IDs of atypical providers. An atypical provider will have a Medicaid ID but no NPI. Social workers who are no longer students but have not completed practice hours would fall into this category. Medicaid wants the Locator and Medicaid ID with a blank NPI. 

· Secondary Payment and Allowed Table: This table file holds all the standard payment and allowed amounts so that you do not have to enter normal payments. You will still have to enter deductible amounts. This option does require a license.

· 90 Day Ind: This is the value that will be sent when the 90 day indicator needs renewal. If you want to override this, you can set the 90 day indicator in billing options / more information 2 screen. 
· CLM01: If you are autoposting, choose PATCODE. For Medicaid manual billing, choose BILLPATFIRST so the remittance will show the patient’s first name. 

· REFEA: If you are autoposting for Medicaid, you must use MCAIDREFEA. For any other insurance company, you may want BILLPATFIRST so that you can see the patient’s first name. 

· REF6R: It is always best to use REF6RNORMAL (which is the bill number – line number). 

· Always Assignment: Check this when you want to always accept assignment, regardless of the flag in Lytec.

· Reason Medicare is Secondary: If all your medicare secondary claims are secondary because Other Liability Insurance is Primary (47), leave this blank. If one of the given reasons for medicare being secondary always applies, enter it. If you want to use insurance custom field 6 whenever medicare is secondary to something other than Other Liability Insurance is Primary, choose I6. 

7. If you are using a new Submitter ID, you may need to send one test batch first. To do that, you will need to turn the test mode on. When the test mode is on, your claims will not ever be paid. Be sure that you turn the test mode off when the test is complete. To turn on test mode: 

a. Choose the File menu.

b. Choose Change Insurance or Table.

c. Choose Change Insurance Test Status

d. Click on the <Open> button. 

e. Click the test button until it is checked. 

f. Hit <YES> if asked.

g. Hit <SAVE>.

h. Hit <OK>.

i. Submit your test using the normal claims submission instructions, (but you may need to check a “test” box on the web site screen).

j. Immediately repeat a-h above to reset your test flag back. 

7. Follow the instructions in the section to “Setup Lytec to Use ClaimMaster for a new practice.” 

Setup Lytec to use ClaimMaster for a new  practice

The following setup must be done in Lytec: 

1. Create the following custom fields.   

(Note that you will not have to create many of these fields, but read though each item to see whether it applies to your practice.) 

· In Lytec, choose settings and then custom fields.

· Only if you have Lytec 2001, create this field. 

· Click on the insurance tab and fill in the following field according to the table below:

	14 
	Lytec version
	text
	4
	2001,

 
	If Lytec2001, enter 2001.    


· If you expect to have to send adjustments, and you bill more than one line per claim. (This can always be added later if you need to send adjustments.) 

· Click on the bill detail tab and fill in the following field according to the table below:

	4
	Original Claim
	Text
	22
	 
	For Adjustment Only, enter original claim #


· If ClaimMaster will process Blue Shield: 

· Click on the insurance tab and fill in the following field according to the table below:

	10
	Special Type
	text
	1
	N,B,C,H, R
	B for Blue Cross; C for commercial; H for HMO; R=CareCore
M = Medicaid Clinic being sent via commercial (MC, MC)


· If ClaimMaster will process any secondary claims in this practice: 

· Click on the bill detail tab and fill in the following 2 fields according to the table below:

	Field#
	Name & Prompt
	Type
	Ln
	Values
	Description

	1
	Primary Allowed
	Currency
	
	
	Primary Allowed  

	2
	Primary Paid  
	Currency
	
	
	Primary Paid    

	3
	Blood Test Result
	Text
	7
	
	Blood test result ex: R1*10.5 (R1 = hemoglobin and R2 = hematocrit) and follow with a * and then a result with no more than 1 decimal place.

	5
	Family planning 
	
	
	
	

	6
	Deductible
	Currency
	
	
	Deductible

	7
	CAS CO Reason
	Text
	3
	
	CAS CO Reason code if not 45


Also, click on the bill header tab and add the overridden amount paid. 

	Field#
	Name & Prompt
	Type
	Ln
	Values
	Description

	1
	Override primary allowed
	Text
	
	
	Override Primary allowed.

	2
	Override primary amount paid without copay
	Currency
	
	
	Enter paid amount – patient payments if 5010 and cm2006  and entered copay.


·      If ClaimMaster will process any secondary claims in this practice, AND you charge the primary the allowed amount: 

· Click on the insurance tab and fill in the following field  according to the table below:

	4
	Charge Allowed Amt? 
	Text
	1
	Y = Yes; N = No  
	Enter  Y if you charge same as allowed.  

 


·      If ClaimMaster will process any secondary claims in this practice, AND those claims may have different primary payors, AND you cannot enter the payor ID  that your insurance is expecting into the Lytec payor Id field: 

· Click on the insurance tab and fill in the following 2 fields according to the table below:

	2
	special processing
	Text
	4
	
	PAYR = payor found in field 15

	15
	Payor ID 
	Text 
	15
	
	Primary Payor id only for secondary claims. 


· If ClaimMaster will process any secondary claims in this practice, AND you created a different insurance code just for your secondary claims: 

· Click on the insurance tab and fill in the following field according to the table below:

	5
	Second Ins Indicator
	Text
	1
	S,P
	Enter S if only used as Secondary; otherwise blank


· If ClaimMaster will process Medicare Secondary AND you want to specify the reason Medicare is Secondary (working in conjunction with the ClaimMaster insurance option field "reason medicare is secondary")  This field will be entered in the medicare insurance.

· Click on the insurance tab  and fill in the following field according to the table below:

	6
	Mcare Sec reason
	Text
	2
	12,13,14,15,16,41,42,43,47
	Enter reason medicare secondary*


·  If ClaimMaster will process any MEDICAID claims in this practice: 

· Click on the bill header tab and fill in the following fields:

	3
	Sa exception
	Text
	1
	1,2,3,4,5,6,7
	Enter if medicaid and no auth: 1-7; 7 = none needed

	4
	Void indicator
	Text
	1
	V
	V = Void. 

	5
	90 day ind
	Text 
	2
	1,2,3,4,5,7,8,9,10,11
	Enter only if medicaid and want special 90 day reason

	
	
	
	
	
	


· If you want Medicaid Physical Therapy claims to only send one line with all units :

· Click on the bill header tab and fill in the following fields:   

	6
	Send only 1 line? 
	Text
	5
	
	If only 1 line should be sent: enter units.


· If you are sending commercial Medicaid Clinic claims, you might have to indicate a frequency of continuing care. To do that, set bill custom 6 to 3. 

	6
	Bill Type 
	Text
	5
	
	Only if clinic Medicaid needing continuing care of 3


· If you handle Medicaid Family Planning: (Note: If not all lines are family planning, instead put FP as a modifier on family planning lines instead.) 
	7
	family planning
	Text
	1
	
	If all lines in bill are family planning, enter F. Only for Medicaid when entire bill is family planning.


· If you want this claim to indicate that it was a secondary claim that was never sent to primary because you do not participate and the primary will not pay for the service and you do not participate: (Note: There are other ways to accomplish this as well. It works with the claimmaster replacement tables.)  

	8
	0Fill Indicator
	Text
	1
	
	Y = If you want zerofill processing for this secondary claim


· If you are submitting Medicaid and your locator is not going to be placed in the facility’s insurance code 2 :

· Click on the insurance tab and fill in the following fields:   

	7
	Facility Method
	Text
	1 
	Y,N,T,P,B,S,C
	Medicaid only: P=Prov;T=fac;

N=CM cfg;Y or blank= fac ins id2, B = prov + facility, S=pat type; C=pat code




·  If ClaimMaster will process Podiatry procedures 11055, 11056, 11057, 11719, 11720, 11721, and your Lytec version is 2007, 2008 or 2009. For 2010+, this is not needed. 
· Click on the insurance tab and fill in the following field according to the table below:

	2
	Special processing
	Text
	4
	
	SPVR = use referring provider as supervising provider also when consult 2 is filled. (Only available for Lytec 2007+)


· Make sure you are not using the following fields unless they are used for ClaimMaster

i. On the bill detail tab – do not use field 4 (unless it is for original claim number)

ii. On the bill header tab – do not use field 3-5

iii. On the insurance tab – do not use the following field values in ins 2:

2-Don't use a value of "ZERO", "RTH" or "PAYR" or "DEF" or "REF" or "SA7" or “PTCD”  or "SPVR"
3-Do not use as “C”

4-Do not use as “Y”

5-Do not use as “S”

7-Do not use as P, N or T

10-Do not use as “Y”

12-Do not use as N, O or I

13-Do not use as N or O

14 -Do not use as 2001

2. Update your insurance companies that ClaimMaster will submit, and all insurance companies to which Medicaid is secondary (i.e. Medicare) with the following information: 

· On the name and address tab of insurance, be sure the type is "medicaid physician" for Medicaid and “medicare” for Medicare.

·  The address must be filled.

· On the identification tab for medicare and medicaid, be sure the provider id # is filled in. (If 2010+, the provider id and npi is filled in the provider insurance tab and the practice insurance tab.) 
· If you are submitting secondary Medicaid that is primary to more than one insurance, ensure the correct payor id is in the payor id field for XE and 2004, and “commercial id” for 2001. The proper payor ID for Empire Medicare and Blue is 13202, and the proper payor ID for ghi medicare is  13292, and for RR Medicare is C00882. If this conflicts with the system you use to submit other claims, set the ins custom field 2 to PAYR and place the payor id in custom field 15.   

· If you want the check to go for all claims to go to a provider group’s address, enter their medicaid provider id in insurance / claims / group pratice. Otherwise, the checks will go to the address of the individual doctors. Medicaid must know the practice is a group in order for this to work. The Medicare and Blue Shield Group ID must be 10 digits: The first initial of the first word and the first initial of the second word in the practice name, followed by 0, and then the 6 character medicare id and then 0.  Call Medicare or Blue Shield to validate your ID.  (If 2010+,  the group indication is filled in the provider insurance tab and the practice npi is set in the practice insurance tab.) 

·  (WARNING: Empire Medicare and Blue Shield will not give you an invalid group warning, but will instead just send the check to the physicians instead of the group. )

· If you are submitting Medicaid claims for an optical group physician practice:

· If your Lytec version is below 2010,  go to the identification tab to fill the processing type with OP.  
· If your Lytec version is 2010+, set the insurance submitter ID to OP. 

· (Note: For Medicaid article 28 optical clinics, do not enter OP.)
· To handle   submitting claims for Podiatry procedures 11055, 11056, 11057, 11719, 11720:

· If below 2010: set insurance custom field 2 to SUPR. 
· If 2010+: fill in supervisor on bill. 

· In all cases: When you enter the claims, you will fill in consult 2. 

· If you have Lytec 2001, set insurance custom field 14 to 2001. 

· If you charge allowed amount, set ins custom field 4 to Y for the primary insurance. (For Medicare with secondary Medicaid, this means Medicare will be set to Y, not Medicaid.)

· If you use a separate insurance code just for secondary Medicaid, set ins custom field 5 to S.

· If you always want to use ClaimMaster’s default locator code for the practice, set ins code 7 to N. (Note that only Medicaid Atypical providers use locator codes.) 
· If you are submitting to Medicaid, and you want the locator code to be entered in the facility’s insurance code 2, you do not need to do anything. Otherwise, set custom field 7 as follows: 

· If you want a different locator for each provider, enter P

· If you want a different locator for each provider + facility combination, enter B

· If you want a different locator for each patient type, enter S

· If you want a different locator for each patient code, enter C

· If you want a different locator for each facility, but do not want to use the facility’s Lytec field, enter T

· If you always want to use the claimmaster default locator, enter N

· (Note that only Medicaid Atypical providers use locator codes.)

You will need to create a table to map the facilities if you fill in custom field 7 to match your choice here.

· If you are sending Blue Cross / Blue Shield claims, set custom field 10 to B. 

· If you are sending Clinic Medicaid via Commercial (often Emdeon) set custom field 10 to M and let Octagon Systems know of any insurance companies you are sending to via ClaimMaster so they can be added to ClaimMaster's list. 

· If you don’t want to use the referring provider’s ins code 1 as the UPIN (for medicare) and ins code 2  for license number, set ins custom field 12 to “N”, and add the ClaimMaster provider table.  If you want to use the Medicaid ID instead of the license number, just enter it. ClaimMaster assumes the 8 digit number is a Medicaid ID, not a license. (Note: Only atypical providers need Medicaid IDs now. UPIN is no longer sent for referring providers.)
· If you have medicare secondary and have more than one reason for it being secondary, enter the reason in insurance custom field 6. The reasons can be found in the appendix.

3. On the provider table: 

· Please enter the provider's insurance id under the insurance id # corresponding to your insurance. (In 2010+, this is found in the provider's insurance tab. Legacy IDs are optional in 2010, except for atypical providers. ClaimMaster will only ever use Legacy 1 practice or provider ids. The provider's tab determines whether a claim will be submitted as group or individual. ) 
· For Medicaid: You must use the Medicaid Id instead of the license number if the practice is not a group practice.) 

· If you are submitting Medicare or Blue Shield also with ClaimMaster, fill in the provider’s medicare  or Blue Shield id under the insurance id corresponding to Medicare. The Medicare ID must be 10 digits: The first initial of the doctor’s first and last name followed by 0, and then the 6 character medicare id and then 0. (If the last name is hyphenated, instead use the first 2 characters of the doctor’s last name.)  

· (Note, only atypical providers use legacy IDs now, but in Lytec versions below 2010, you need to enter the id regardless of whether it is sent.) 
· Please enter the provider's first and last name.

· Please enter the provider's tax id or social security number.

· If the insurance company is medicaid physician, and the provider is a social worker who must be supervised:

· If your Lytec version is below 2010:  please enter "SUPERVISED" in provider custom field 8

· If your Lytec version is 2010+, just enter a supervisor code on the bill. 

4. On the address table for facilities: 

· Please enter the locator code in insurance code 2, unless you are just using ClaimMaster’s default locator code, or a locator mapping file. (Note that only Medicaid Atypical providers use locator codes.)
· Please enter the name and address of the facility.

· facility id1 OR legacy id 1 = provider number for Home Health Care agency for G0180 and G0179 procedures as first line on bill  (Note: placing H in insurance custom field 9 surpresses this.) 
5. On the address table for referring doctors: 

· Enter NPI of the referring doctor

· Please enter the first and last name of the referring provider
6. On the practice settings: 

· For Lytec versions below 2010: Please enter the name and address    and tax id   

· For Lytec versions 2010+: Please enter the name and address and npi and tax id and legacy Medicaid id 

7. On the Bill Detail: 

· For a secondary claim, please see the Daily Use section to determine what needs to be entered here. For a primary claim, you never have to enter billing detail custom fields. 

REFERENCE - LYTEC INFO USED BY CLAIMMASTER  

Practice information: 

· Tax id (If you enter a social security number here, please be sure to indicate that on the Claim Master configuration.)

· Name

· Address

Insurance information: 

· Fill in all custom fields.

· Fill in the insurance/claims/group practice id, unless you don't want the check sent to the practice

· Fill in the insurance / identification / provider id to indicate which license number corresponds to this insurance.

· payor id: medicaid: 14179 7357;  empire medicare: 13202; ghi medicare: 13292. ; RR medicare C00882; Availity and Commercial will use the payor id given. 
· Fill in Medicaid's insurance / identification / Processing type with OP to indicate that you are billing Medicaid for an Optical group practice.  (Note: For Medicaid article 28 optical clinics, do not enter OP.) (For Lytec 2010+, enter OP in insurance submitter ID.) 
For every facility you use, change lists/addresses to have the following information filled: 

· Facility name

· address

· city

· state

· zip

· facility id2  (or legacy id 2) = locator if use facility for locator on insurance = Y (Note that only Medicaid Atypical providers use locator codes.)
· facility id1 (or legacy id 1) = if clinic: enter pos if use facility for loc  on insurance =  Y; Also if you perform mammography (cpt codes  76090, 76091, 76092, 77057, 77056 or 77057 ), you will need to enter your facility authorization number here. 

· facility id1(or legacy id 1)  = provider number for Home Health Care agency for G0180 and G0179 procedures as first line on bill  (Only if sending legacy numbers).
For every patient, you must fill out the following information: 

· First

· Last 

· Middle

· Primary and secondary insurance id

· Birth Date

· Sex

· Chart number

· address

· city 

· state

· zip

· If medicaid handicapped program,  then go to claim information/champus: enter anything in handicapped program.

· Note: Medicaid EPSDT is handled per bill, not on the patient. Medicaid Chap referrals are handled within the Place of Service code on the bill, not on the patient.

· If the patient is disabled, enter dates in either the full or partial disability start dates in the more claim information/More information screen. When the disability has passed, these dates should be cleared. You can add them as patient notes instead.

For every referring doctor, change lists/addresses to have the following information filled:

· doctor first name

· doctor last name

· address

· city

· state

· zip

· Enter the lic

· NPI

For every charge, the following information will be used from the header:

· Billing number

· Hospital admission date

· Emergency check box

· prior authorization number

· for lytec xe, orig claim number 

· all custom fields

· referring doctor

· date of last x-ray

· consultation dates

· symptom date (For last time consulted with a physician, which all physical therapy claims need, it will use the last consultation date if it is filled. If there is no last consultation date, it will use the last symptom date.) (For claims for whose first CPT is 98940-3, the symptom date will be used as the initial treatment date.)

· hospitalization dates

· accident information

· claim form box 19 will be sent as claim notes.

· sa exceptions are entered on the custom field, and the following values are valid: 

// 1 immediate/urgent care

// 2 services rendered in retro-active period

// 3 emergency care

// 4 client has temporary medicaid

// 5 request from county for second opinion to dermine if recipient can work

// 6 request for override clming

// 7 special handling (now must be used if no UT is needed)
· If Medicaid EPSDT: if you use EP as the modifier of the first line on the bill, the EPSDT Referral code of ST will be chosen for you. If you don't want ST, fill in the EPSDT Referral field in the bill option, more information tab: 

· AV : Available - Not used meaning Patient refused referral. 

· NU : Not Used (meaning no referral, and it will not be considered EPSDT) 

· S2 : Under Treatment (meaning Patient is currently under treatment for referred diagnostic or corrective health problem.) 

· ST : New Services Requested or continuing treatment (meaning  Referral to another provider for diagnostic or corrective treatment/scheduled for another appointment with screening provider for diagnostic or corrective treatment for at least one health problem identified during an initial or periodic screening service (not including dental care)

For every charge, the following information will be used from the individual lines:

· Bill line number

· Extended charge

· Place of service code (if not medicaid)

· Date of Service from

· Date of Service to, but no need to enter if it is the same as the date of service from. (For clinic claims, every visit date must be on separate lines.) 

· Diagnosis 1 –5 (5 per claim)

· Transaction code’s cpt code

· Units

· Mod 1-4

· notes that are marked to print on claim. (but these are not sent for clinic medicaid). 

· Bill detail custom field 3: For proc codes J0881, J0882, J0885, J0886 and Q4081, enter R1 (for hemoglobin) or R2 (for hematocrit), and then an asterisk and then enter the 3 digit test result with a decimal point and Ex: R1*13.5 
· Enter the ndc code in 5-4-2 format in custom billing detail field 3. This means you have to pad each section with leading zeroes in the front to reach a 5-4-2 format. Then enter a * and the drug unit charge, a *, the dispensing quantity, a * and finally,the Unit of Measure. The unit of measure can be F2 = intl unit; GR = gram; ML = milliliter; UN = unit.  Ex: 01111001101*2.50*50*GR. The total of the drug price * the dispensing quantity  must equal the total line charge. Claim Master is not currently editing these fields to ensure the values are correct. 
The following information must be filled on every provider:

· First

· Middle

· Last

· Tax id or SS# (if both, will use SS#) OR fill this in on the provider table

· Provider id for insurance (expect professional code + license properly formatted, or assigned id).

· If tax id or SS AND provider ID are filled in Lytec, AND provider has an id from the insurance company, you do not need to have a row on the Claim Master provider table. In any other case, the provider must be entered on the table. 

· For Medicaid physician, for supervised social workers, enter "SUPERVISED" in custom field 8.

Transaction code

· Will use the cpt code

File extensions used: 

	File
	Extension

	configuration file
	.cfg

	table file (provider and facility)
	.tbl

	control files
	.ctl

	input filesx
	.inp

	pending transmit files
	.clm

	sent transmit files
	.sent

	error report files
	…err.html

	valid claim report files
	…rpt.html

	claim index file
	.cli

	input file copy
	.cpy


REFERENCE: Listing of the custom Insurance Fields:

· First, do not use the following values in the following Insurance custom fields for any uses other than ClaimMaster:
 

	#
	ClaimMaster values: 

	2
	Don't use a value of "ZERO", "RTH" or "PAYR" or "DEF" or "REF" or "SA7" or “PTCD” 

	3
	Do not use as “C”

	4
	Do not use as “Y”

	5
	Do not use as “S”

	7
	Do not use as P, N or T

	10
	Do not use as “Y”

	12
	Do not use as N, O or I

	13
	Do not use as N or O

	14 
	Do not use as 2001


For a default setup, no custom insurance fields are required. Look at the “Why used” column in the table below to see whether you need to set up any of the insurance company custom fields:

	Why used?
	Field#
	Name  
	Typ
	Ln
	Values
	Prompt

	* see below
	2
	special processing
	Text
	4
	
	See below

	If you charge the allowed amount
	4
	Charge Allowed Amt? 
	Text
	1
	Y = Yes; N = No  
	Enter  Y if you charge same as allowed.  

 

	If mcaid secondary is a different code then mcaid primary
	5
	Second Ins Indicator
	Text
	1
	S,P
	Enter S if only used as Secondary; otherwise blank

	If you don’t want to use the facility ins id 2 for the locator code.
	7
	Use facility?
	Text
	1 
	Y,N,T,P,B,S,C
	Medicaid only: P=Prov;T=fac

N=CM cfg;Y or blank= fac ins id2, B = prov + facility, S=pat type; C=pat code



	If you bill G0180 or G0179
	9
	Supress HHA?
	Text
	1
	H
	H = Supress the Home Health Care number (fac id 1) for CPTs G0180 and G0179

	If you purchased the Blue Cross ClaimMaster option.
	10
	Special Type
	text
	1
	Y,N,B
	B for Blue Cross; C for commercial; H = HMO;
R = CareCore

	If you have Lytec 2001
	14 
	Lytec version
	text
	4
	2001,2005
	If Lytec2001, enter 2001. If Lytec2005 and you have Automatic Remittance, enter 2005. Otherwise blank.

	If you are using the special processing “PAYR”  option.
	15
	Payor ID 
	Text 
	15
	
	Primary Payor id only for secondary claims. 


* For field 2, special processing, you can use any of the following options: 

· If you want to use the patient’s policy number (group # if XE) instead of the insurance id, add insurance custom field 2 as “RTH”. 

· If you do not want to use the payor id field for medicare as the primary insurance on a secondary Medicaid claim, and you have both Empire and GHI medicare, add insurance custom field 2 as “PAYR”, and insurance custom field 15 as payor id. (If you only use one type of medicare, you can instead set the primary payor id in the ClaimMaster configuration.) 

· If you only want the referring doctor to be placed on the claim if ins code 2 is filled for a Medicaid claim or ins code 1 is filled for a Medicare claim, you can enter “REF” in ins custom field 2. 

· If you want to send all claims with an SA exception code of 7, which should only be done with Medicaid’s permission, enter “SA7” in the ins custom field 2. 

· If you want to summarize a PT claim into just one line detail, enter PTCD.

· If you want to use a different Tax ID just for this insurance, enter PTAX in special code 2 and the Social Security number in custom field 1. The tax id is assumed to be a social security number.

· For Podiatists who perform procedures 11055, 11056, 11057, 11719, 11720, enter SPVR in custom code 2, and then be sure to fill in consult 2 on all those claims. 

NPI Notes

Use settings / change system default to set the NPI options for all systems. 

TROUBLESHOOTING GUIDE

Cannot file Lytec billing file

Symptom: When you select Lytec billing file, it does not show you the Lytec billing file.

Solutions: The Select Lytec billing file option shows all the files in the Lytec Billing Directory for the insurance company chosen. Answer the questions below:

Did you ever print a ClaimMaster claim for that company using a form that begins with “edi”? If not, print the claim before looking for the claim in ClaimMaster.

Is the name of the company and insurance company at the top of the screen in the blue bar? If not, the practice and insurance were not properly set. Close ClaimMaster and restart it. Then, follow the instructions  for starting ClaimMaster in the beginning of this manual. After you select the insurance company, you should see the name on the top of the screen.

If the company and insurance company were at the top of the screen, then the Lytec Billing Directory is probably pointing to the wrong directory. To see the Lytec Billing Directory, Choose File / “Change insurance or table file” and then double click on the insurance company. See the “Lytec Data Dir.”  That must be set to your practice’s Lytec data directory. For Lytec/XE you can find your Lytec data directory, by going to the Lytec file menu and choose open. Lytec/XE will show you the path right on your screen.  If you see it is incorrect, change Lytec Data Dir and press Save and OK and then try again to Select Lytec Billing File. 

If that still does not work, right click on your start menu and choose explorer. Navigate to your Lytec data directory and then to your practice. (If you are using ClaimMaster over a network, you can choose “my network places” to navigate.) On the top, you should see the full path of the Lytec billing directory.  (If you do not, choose tools / folder options / view, and check “Display the full path in the address bar”.) Highlight that directory path in the address bar and press edit / copy. Then, paste that into the Lytec Data Dir by highlighting the current path and pressing <CTRL> and “v” at the same time. Press Save and OK.

ClaimMaster Tables

Locator Table:

This table works in conjunction with the insurance custom field 7. (Note that only Medicaid Atypical providers use locator codes.) The possible types of tables are: 

	Code
	Table Lookup

	P
	Provider

	B
	Provider + facility (with no space inbetween)

	S
	Patient Type

	C
	Patient Code

	T
	Facility


Create the table from a template or a copy of an existing system. Then, change the first value in each line to match the value you entered in insurance custom field 7.  The locator code follows the key, and the Medicaid clinic POS follows that, and finally, the name of the location follows. * can be used in the key as a catch all. 

For Example, a type B (provider + facility) would look like: 

MINT001,03,,Dr. Mint 001 facility

After creating this table, place its name into the insurance configuration’s locator table using the ClaimMaster Option “Change Insurance Practice Values”.

Pay Table: 

This table requires a pay table license. You can create the table first from a template or a copy of an existing system.  This is a list of allowed and payment amounts for each procedure in each year, and can be specific for each primary insurance company. You set up the table for the secondary insurance, listing the normal payment rates for all the possible primary insurances. 

You only need to include the insurance company when you have more than one primary insurance for a secondary. (For example, if Medicaid is secondary to GHI Medicare and Empire Medicare.) Your table should all use the insurance company or none should. 

 (GHI Medicare's payor ID is 13292. Empire Medicare's payor ID is 13202; Railroad medicare is C00882.)

Each line starts with the procedure plus a “-“ plus the year, and optionally plus another “-“ and the insurance company.  It is followed by the allowed amount and the amount usually paid. 

Be careful to have only 2 commas and no spaces. The Code may contain special characters '?' and/or '*'.   '?' means single character substitution while matching Procedure code. '*' means wildcard substitution while matching Procedure code.

 Limitations:  Only the first '*' character in the Procedure code string is used for wildcard substitution.  

  If the procedure code contains more than one '*', then the others will be used for literally matching.

   ex: 9*9-2005, 122.00, 22.00 OR ex: 95?5*, 23355

Example without insurance company: 

76536-2005,106.7,85.36
   

76700-2005,150.16,120.12


Example with insurance company: 

76536-2005-13292,106.7,85.36
   

76700-2005-13292,150.16,120.12


After creating this table, place its name into the insurance configuration’s locator table using the ClaimMaster Option “Change Insurance Options”.
Tax ID Table:

If you have Lytec 2010+, just indicate the social security or tax id on the practice and provider. All this other setup is for Lytec versions below 2010. 

Use this table only when you want to use a different tax id than the system would normally use. To use this table, create the tax id table and tell ClaimMaster to use it for a certain configuration: Use the File / Change Insurance or Table / Change Insurance Options, and browse for the tax id table using the Tax Override Table browse button. 
If you are using a tax ID, the practice tax ID will normally be set according to the following: 

	Level
	Setup in Lytec
	Source of Tax Id
	Tax Type

	Group Practice   
	Insurance claim tab group ID is filled and ins custom 2 is not PTAX  
	Practice Tax ID
	If Lytec 2006+: uses practice billing service extra field 1. If S, it makes the tax ID an SS.

If Lytec 2005-: Uses ClaimMaster config SS or Tax mark on the "change insurance standard values" screen 

	Group Practice  
	same as above except ins custom 2 is PTAX
	Ins custom field 1
	SS

	Provider (insurance has no group practice id)
	Tax ID filled
	Provider Tax ID
	Tax ID

	Provider (insurance has no group practice id)
	No Tax ID filled 
	Provider SS ID
	SS


You can use the tax id table when you want ClaimMaster to use a different tax id than the above schedule. For any combination of insurance, facility and provider, you can indicate that the provider’s social security or provider’s tax id should be used instead. This is needed when you commingle groups in one Lytec practice and when you have providers who sign up for an insurance using their social security number instead of their tax id. 

Create a table using the taxid.tbl template. Identify the Lytec insurance, provider and facility codes. Use an asterisk if you want all codes to use this tax scheme (ex: * as provider will match all providers). You can also place an asterisk to indicate any characters can match as part of a code (ex: FAC1* would match all facilities starting with FAC1.) When ClaimMaster finds a match, it uses the tax scheme indicated in the last value on the table: 

SS  means that ClaimMaster will use the provider's social security number

PX means that ClaimMaster will use the provider’s tax id for a group, instead of using the practice tax id

TX means that ClaimMaster will use the tax id as normal.  (see table above); This is the same as not putting this entry on this table at all, as it changes nothing.

Here is a sample: 

INS1,PRV*,FAC1,SS // ins1, any provider beginning with PRV,  fac1 should be ss# 

INS1,PRV2,FAC1,TX // ins1, prov2 fac1 should be provider tax id

*INS2*,PRV2,FAC2,SS // any insurance with INS2 inside it, prov2 fac2 should be ss#  
INS3,PRV1,FAC1,PX // ins 3, prov1, fac1 claims should use tax id of provider, not of practice.

How to handle adjustments and deductibles when you are using the 2011 CM:

Deductibles can either be entered in custom field 6 or in the payment note. Inside the note, the format is: PR01 : -5.42 Deduct
If you use a modifier of U2, the entire allowed amount will be moved to deductible.
When you have the sql link for payments: It will always add both primary and secondary payments into the paid field. 
Regardless of whether you have the sql link for payments: If you are sending an adjustment to a secondary payment, please enter the paid custom field. To prevent lines that should be reprocessed with the primary from being sent to the secondary, claimmaster gives an error in the following case:

  payment amount is 0

  AND allowed custom field is 0

  AND charge is greater than 0 

  AND dedcutible is 0

To pass this claim through to claimmaster, just enter the allowed amount. 

So, for adjustments, you will need to enter the TCN plus the paid.When nothing was paid or deductible, enter the TCN and the allowed amount. You must enter 2 custom fields to send an adjustment. 

90 day values: 
1 proof of eligibility unknown or unavailable
2 litigation
3 authorization delays
4 delay in certifying provider
5 delay in suppying billing forms
7 3rd party processing delay
8 delay in eligibility determination
9 original claim rejected or denied due to a reason unrelated to the billing limitation rules
10 administration delay in the prior approval process
11 other

Reasons Medicare may be secondary (for ins code 6):

12 Medicare Secondary Working Aged Beneficiary or Spouse with Employer Group Health Plan
13 Medicare Secondary End-Stage Renal Disease Beneficiary in coordination  

14 Medicare Secondary, No-fault Insurance including Auto is Primary

15 Medicare Secondary Worker’s Compensation

16 Medicare Secondary Public Health Service (PHS)or Other Federal Agency

41 Medicare Secondary Black Lung

42 Medicare Secondary Veteran’s Administration

43 Medicare Secondary Disabled Beneficiary Under Age 65 with Large Group Health Plan (LGHP)

47 Medicare Secondary, Other Liability Insurance is Primary
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